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Purpose 
The purpose of this guide is to provide step-by-step instructions on how to create 
accessible documents and posts in: 

• Microsoft Word 
• Microsoft PowerPoint 
• Microsoft Excel 
• Adobe PDF 
• Adobe InDesign 
• Canva 
• Social Media 

Resources 
Accessible Web Content Requirements: 

Web Content Accessibility Guidelines (WCAG) 2.0  
 
Accessible Social Media Posting: 

Tips for Making Social Media More Accessible -Ryerson University  
Social Media Accessibility -University of Guelph 
Accessible Digital Media Guidelines -GBH 
 
Accessible Adobe Documents: 

Create and Verify PDF Accessibility (Acrobat Pro) 
Creating Accessible PDFs 
Three Steps to Creating an Accessible PDF file (without Adobe Acrobat) 
Adobe Accessibility Resources  
Adobe InDesign Accessibility 
Adobe Acrobat Pro DC -Common Accessibility Issues 
 
Accessible Microsoft Documents: 

Microsoft Accessibility 
Microsoft Accessibility Resources 
Microsoft Accessibility Overview Guidelines 
Creating Accessible Office Documents 
Make Your Word Documents Accessible  
Make Your Excel Spreadsheets Accessible 
Make Your PowerPoint Presentations Accessible 
 
Accessible Canvas: 

Creating Accessible Canvas Content 
Canvas Accessibility  
 

https://www.w3.org/TR/WCAG20/
https://www.ryerson.ca/accessibility/guides-resources/social-media/
https://www.uoguelph.ca/diversity-human-rights/sites/default/files/Accessible%20Social%20Media.pdf
https://www.wgbh.org/foundation/ncam/guidelines/accessible-digital-media-guidelines
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html
https://www.framingham.edu/Assets/uploads/about-fsu/accessibility/_documents/3-steps-accessible-pdf.pdf
https://www.adobe.com/accessibility/resources.html
https://www.adobe.com/accessibility/products/indesign.edu.html
https://www.seattleschools.org/wp-content/uploads/2021/07/AdobeCommonAccessibilityIssuesQRD.pdf
https://www.microsoft.com/en-us/accessibility
https://www.microsoft.com/en-us/accessibility/resources?activetab=pivot_1%3aprimaryr3
https://docs.microsoft.com/en-us/windows/apps/design/accessibility/accessibility-overview
https://support.microsoft.com/en-us/office/create-accessible-office-documents-868ecfcd-4f00-4224-b881-a65537a7c155
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.microsoft.com/en-us/office/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://support.emerson.edu/hc/en-us/articles/205015539-Creating-Accessible-Canvas-Content#how-to-add-heading-tags-0-6
https://www.w3.org/Talks/2014/0510-canvas-a11y/#1
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Creating Accessible Word Documents  
For the full details on how to create accessible documents in Microsoft Word, go to the 
following: Make Your Word Documents Accessible  
 

Styles 
Referencing the Headings section above, the Styles should be used to make the 
document easier to navigate for users with assistive technology. 

Word has built in styles available. The Normal style is the default paragraph style for all 
text in the document. 

Other ones that may be used include: 

• No Spacing  
• Heading 1 – 5  
• Title 
• List Paragraph 

 
To modify the Styles in a Word document, follow the instructions under the Headings 
section.  

 
The font selected should align with the list of Accessible Fonts provided in this 
document.  

Headings 
Documents that have several paragraphs should include the use of headings. Headings 
create logical divisions between paragraphs and are structural elements that provide 
meaningful sequence to users with assistive technology. 

Headings are found under the Styles ribbon. It is important that headings are nested 
properly in the document.  

Example of appropriate use of headings: 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
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To apply a heading: 

1. Highlight the text you wish to apply the heading to 
2. Select the appropriate heading from the Styles list  

Word provides a Navigation menu that can be used to look at the headings, pages, 
and results. Under the headings tab you can see if the sequential order of the headings 
has been done appropriately. You can move headings or text up or down to rearrange 
the sequence.  

1. Click on the View ribbon 
2. In the Show section, click the check box beside the Navigation Pane 
3. The Navigation pane will open to the left of the document  
4. Click the Heading menu to see all the heading levels in the document  
5. You can review the levels to ensure you have not skipped any or that they are 

nested appropriately so users with assistive technology will be able to access the 
headings  
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Alternative Text  
Per the instructions on Alt Text it is important to note that you do not fill in the Title 
column, only put a description, if applicable.  

Right click the object (image) 
Select Format Picture (the Format Picture window opens on the right side) 
Select Layout & Properties 
Select Alt Text 
Fill in the Alterative Text under Description (leave the “Title” blank) 

 
Information conveyed in the image must be available in another format for those that 
cannot access the image. The Alt Text is not intended to describe all the information 
contained in the image. It is best practice not to use images that provide a lot of details, 
or to ensure that the details are included in the caption, or below the image.  

When setting up the Alt Text try to answer the question “what information is the 
image conveying?” 

If the meaningful information in the image cannot be included elsewhere, ensure that 
the Alt Text includes all the meaningful information. 

Avoid using excessive amounts of images when possible, especially decorative ones.  

Example of image with meaningful text: 
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Information that must be available in another format (text): 

Wash Your Hands: wash them often with soap for at least 20 seconds 

Coughing Etiquette: cover your mouth when you cough or sneeze with tissue or 
the inside of your elbow 

Wear Mask: make sure your mask fits well with the nose clip 

Avoid human Contact: keep a distance of 1 meter away from others  

The same information provided in the image should be available to all people, 
with or without a disability.  

The reason it should not be summarized is because the person with a disability 
will not have the option to determine what is meaningful and what is not 
meaningful to them. This may differ from one individual to the next.  

As the document author, you must decide if the image contains information that is 
useful to the reader of the document. If it is meaningful information, it must have an Alt 
Text and the information must be available in another format.  

If the image is complex or has a lot of information that cannot fit in an alt text, provide 
the information or describe the image (example: graph) in the space below the image.  

Long Descriptions should be used when alt texts are insufficient to answer the 
question what information is the image conveying.  

Lists 
The List Paragraph style can be used when inserting a list in the document. It is 
important that it is formatted as a real list or the assistive technology may not interpret 
the list appropriately and instead it will read as a series of short separate paragraphs.  

Using the List Paragraph style allows assistive technologies to identify and interpret 
lists in a way that is easier to understand for the user. 

If the list is ordered, meaning it must be read in a specific order, use numbers. If it is 
unordered, meaning it can be read in any order, use bullets.  

Ordered: 

1. First you must open X 
2. Then you should locate Y 
3. Lastly you must find out how to connect X and Y to Z 

Unordered: 

• Use accessible language  
• Avoid gendered pronouns 
• Use up-to-date terminology  
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Page Breaks and Blank Spacing 
The Page Break feature helps users that require assistive technology.  

When starting a new page, select the Page Break feature instead of repeated hard 
returns (enter key). Assistive technology interprets hard returns as content. With too 
many hard returns, assistive technology users may think that there is no more content in 
the document and miss the valuable information you are providing.  

Page Breaks can be found under the Insert tab, or for other types of Breaks, click on 
the Page Layout tab and choose the down arrow beside Breaks. 

 

 
Alternatively, right click on the paragraph or heading that you want to move to the next 
page, and select Paragraph  

Click on Line and Page Breaks and check the box that says page breaks before to 
insert a page break 
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If you have too many blank spaces in the document, it will show up as an warning under 
the accessibility checker, called: repeated blank characters  

Avoid using the enter key to make blank spaces throughout the document. If you do not 
want to create a page break but need to put space between sections on the same page, 
do the following: 

1. Right click at the end of the text where you want the space to begin 
2. Select Paragraph and go to Indents and Spacing 
3. Find the section called Spacing  
4. Using the up and down buttons add spacing either before or after to create a 

blank/white space between sections  

 

Table of Contents 
Creating an index or table of contents can help provide information on how to navigate 
the document and what topics the document will provide details on. 

To insert a Table of Contents 

1. Place the cursor in your document where you want to create the table of contents 
2. Go to the Ribbon: References 
3. In the Table of Contents section, select Table of Contents 
4. Select the style that you want to use 

 
Change the Table of Contents to match the headings throughout the rest of the 
document to ensure consistency. 
 
To update the Table of Contents 
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1. Select the Table 
2. Go to the ribbon: References 
3. In the Table of Contents section, select the Update Table button 

 
The table will automatically update the page numbers and heading titles. You can 
manually change the table to include only the sections you want.  

 
 
Tables 
Tables can be beneficial when presenting data, but it is not ideal to use for formatting 
other content that does not need to go in a table.  

It is important to ensure tables are clear and appropriately structured. This ensures all 
users can understand the content in the table and that assistive technologies can 
interpret the table in the way it is intended.  

Tips for Tables 

• Use ‘real tables’ rather than text formatted to look like a table  
• Keep tables simple and avoid merging or splitting cells  
• Use just one row of headings when possible  
• Create a table summary of the essential table contents  

o Abbreviations should be explained in the summary  
• Table captions or descriptions should answer the question “what is the table’s 

purpose and how is it organized” 
• Table cells should be marked as table headers when they serve as labels to help 

interpret the other cells in the table  
• Table header cell labels should be clear and concise  
• Do not control spacing in your table with blank rows or columns, instead adjust 

line spacing  
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Adding Tables 

1. Go to the Insert tab 
2. Select the Tables icon 
3. Select the number of columns and rows you want  
4. Select the table and Table Tools menu item should appear 
5. Go to menu item Table Tools > Design 
6. In the Table Style Operations section, select the Header Row check box 
7. If adding an Alt Text right click on the table and select Table Properties 
8. Click on the Alt Text tab and provide details on the table  

Identify the Header Row 

1. Select just the top row of your table, right click and choose Table Properties 
2. Select the Row tab 
3. Check the box labelled Repeat as header row at the top of each page  

 
Using Colour 
It is better to avoid using colour when possible, however if you are going to use colour 
for the table, ensure that the colour is selected from the colour options in this guide.  
 
Charts 
Charts, graphs, and complex images are difficult to describe in an alt text. To resolve 
this, consider: 

• If it is possible to simplify the chart or split it into multiple charts  
• If the image is still too complex, provide a text description elsewhere and 

consider including “Full text description is provided below” in the alt text section 

For the example below, you can include an Alt Text that says “Average Ontario Works 
caseload per year spanning from 2011 to 2015.” 

 

Links 
Use descriptive links, do not just copy and paste the link into the document.  

Avoid using words like click here, read more, visit this link etc. as it is not clear what 
page the users is being redirected to. 

478 483 478

455

491

430
440
450
460
470
480
490
500

2011 2012 2013 2014 2015

Average Ontario Works Caseloads
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The name of the hyperlink should match the title of the page that the user is visiting to 
make it easier to identify if the page is the correct one that the user wants to visit.  

Inaccessible Links: 

If you are looking to access more information on making word documents accessible, 
click the link: https://www.mtu.edu/accessibility/training/documents/microsoft-word/  

To read more on this topic, click here. 

Accessible Links: 

If you are looking to access more information on making word documents accessible, 
visit the Michigan Tech page on Creating Accessible Microsoft Word Documents 

To read more about using screen readers in Microsoft, check out the following page, 
Screen Reader Support for Word 

Note: it is important to minimize putting several of the same links in the same 
section. This is considered a redundant link and can be confusing to screen reader 
users. Only include the link once in the same section on the page. If the link is being 
mentioned in different places throughout the document, then it can be included multiple 
times as long as it is spread out and not side-by-side.  

Accessibility Checker 
Using the instructions provided in the guide, check the accessibility of the document. 
For more help, visit: Improve accessibility with the Accessibility Checker 

The Accessibility Checker will categorize the issue as an error, warning, or tip. 

Error: content that makes the document difficult or impossible to read and understand 
for people with disabilities 
 
Warning: content that in most (but not all) cases makes the document difficult to 
understand for people with disabilities 
 
Tip: content that people with disabilities can understand but that could be presented in 
a different way to improve the user’s experience  
 
Intelligent Services: content that is automatically made accessible by AI, and that you 
should review for accuracy and context  
 
For more information on this, go to Rules for the Accessibility Checker 
 
It is important to note that the accessibility checker will not always capture every 
accessibility issue in the document. Once the document is converted to PDF it will 
need to be screened again to ensure it is accessible. Making it accessible in Word 
should reduce potential errors that could be flagged in PDF. There are some errors that 
can occur in either Word or PDF that need manual checking.  

https://www.mtu.edu/accessibility/training/documents/microsoft-word/
https://support.microsoft.com/en-us/office/screen-reader-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c
https://support.microsoft.com/en-us/office/screen-reader-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
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Common Accessibility Issues and How to Fix It in Word 
No Header Row 
This happens when the table header row is not specified or clear.  

 
Ensure the Header Row is checked off under the Design tab for the table. If this does 
not work, in the Layout menu, highlight the first row and select Repeat Header Rows. 

  
Note: if the table goes onto more than one page, it will repeat the header row on each 
new page. To avoid this from happening, click on the first column in the first row on the 
new page and select Insert > Page Break  

Then highlight the first row on the same page and select Repeat Header Rows. You 
will have to do this for each page the table is on to avoid having repeated header rows. 
It will break the table up into sections but still look connected.  
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Missing Alternative Text 

 
If the image does not have an Alt Text, it will be flagged as an error.  

If the picture is inserted by using Insert > Pictures then it should give the option to fix 
the alternative text by clicking on the image in the Accessibility Checker, and using the 
dropdown menu select either Add a Description or Mark as Decorative.  

Click Add a Description if the image is not decorative, it will open the Alt Text menu 
where a description can be added.  

Alternatively, right click on the image and select Edit Alt Text from the menu.  

If the image is decorative, select Mark as Decorative or check the box for this in the Alt 
Text menu. 

 

Missing Heading Level 
It is important for headings to be in order from H1-H9 and on. If a heading level is 
skipped, the accessibility checker will flag this as an error. 
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To fix it, click on the heading in the Accessibility Checker and using the dropdown 
menu, click Verify Heading Order.  

Once determining which heading level the header should be, go to the Home menu, 
highlight the header, and select the correct heading.  

 

Image or Object Not Inline 
If the image is not inline with the text it will be flagged as an accessibility error.  
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To fix this, click on the graphic (image, or object) that is not inline, using the dropdown 
menu, click Place This Inline. This will move the image to be inline with the text.  

Although this seems like an easy fix, there are times when the image being placed inline 
will distort the layout of the page. If using an image in a header, consider using a table.  

First click the header row of the document and Insert a Table with 2 columns and 1 
row. Using the mouse, hover over the middle line of the table to readjust the cell sizes 
to fit the image and the title. Add the image to the first column, and the title of the 
document to the second column.  

Use the Title style if applicable, and add an Alt Text to the image.  

Use the align right option for the title to move it to the right side of the cell. Once the 
font, format, and layout are done, highlight the table and using the option in the 
Paragraph box on the Home menu, select No Border to remove the table lines. 

  

Merged of Split Cells in Table 
Although this is a warning, it is best practice not to use merged or split cells in a table if 
it will not be accurately interpreted by screen reader technology.  

 
To fix this, click on the Table Cell results in the accessibility checker, and using the 
dropdown menu select either Split Cells or Merge Cells depending on which is being 
flagged, ensure the suggested number of rows and columns is correct, and click Ok.   
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Alternatively, split or merge the cells by highlighting the cell that is causing the warning 
and right click to show the menu options. Select Split Cells or Merge Cells from that 
menu.  

The text may incorrectly readjust, you might have to copy and paste the information 
back into the correct cell when splitting or merging the cells.  

Repeated Blank Characters 
This is a warning that creates white spacing on the page, which could be done by using 
other methods to spread out the content without creating extra white space that screen 
readers will pick up.  

 
To fix this one can remove the blank characters by clicking on the characters in the 
accessibility checker menu, and using the dropdown menu select Remove Blanks.  

However, sometimes the blanks are necessary for the document. There are a few ways 
to fix this. If the blank characters are showing up between text or images that are not 
supposed to be close together but cannot be separated with a page break, try removing 
the blank spacing manually until you get the layout you want but without blank spacing. 
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If the layout with the blank spacing is similar to a table (see below) and you are using 
the tab key to space it out, consider using a table and removing the borders.  

 
To add blank space on the same page without using a page break, go to the section 
called Page Breaks and Blank Spacing on page 39 for instructions. 

Hard-To-Read Text Contrast 
Colour contrast is a requirement that must be met under the WCAG 2.0 Level AA. The 
guide outlines the colours that can be used under the Font Colour Options on page 6-
7 and in Appendix H.  

  
The background colour must ensure compliance with this requirement. Use the Colour 
Checker (instructions on page 12-14) to determine if the colour contrast is accessible. 

To fix the colour contrast, select the font that comes up as a warning in the accessibility 
checker, and using the dropdown menu change the font or background colour.  

Other Potential Warnings 
Unclear Hyperlink Text -this is when the link needs to have a clear title. The title 
should match the page title that the user is being redirected to. 

Check Table Reading Order -this requires a manual check to ensure the table reading 
order will be interpreted by screen readers. Use the tab key to check the order. 

Blank Rows or Columns in Table -put n/a or no data in the blank column/row. To hide 
the text, make the font colour the same as the background colour.   
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Creating Accessible PowerPoints 
For the full details on how to create accessible documents in Microsoft Word, go to the 
following: Make Your PowerPoint Presentations Accessible 
Use Built-In Layout and Styling Features 
PowerPoint does not offer the Styles panel that allows heading customization like Word 
does. Instead of creating each slide by starting from a blank slide, check if there is a 
suitable built-in layout. 

For presentations created by the County of Middlesex, use the accessible PowerPoint 
template that uses the County logo and colours.  

For slides that do not have to use the County template, apply a layout to the slides: 

1. Go to the menu item Home 
2. In the Slides section select the Layout button 
3. Select the layout using the drop-down menu and apply it to the slides  

 
4. Alternatively, click on the Design tab and select the Theme from that menu 

 

Customize Using Master Slides 
If a layout must be customized, it is recommended that Master Slides be used. 

Every slide layout in a presentation is defined by its master slide.  A master slide 
determines the formatting style for various elements of the slide layout.  This includes 
font styles, character formatting, and the positioning of elements.  Essentially, each 
master slide acts as a design template for the slide layout.   

If you edit any aspect of the slide layout in the master slide, the change will affect all 
slides that were created based on it.  For this reason, it is good practice to edit the 
master slide and use the slide layouts before building individual slides.  It is essential 
that you create and use master slides that meet the accessibility requirements outlined 
in this document. 

https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#PickTab=Windows
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To create or customize a master slide: 

1. Go to menu item: View 
2. In the Presentation Views section, select the Slide Master icon 
3. The current slide master with its associate layouts appears 

Note: If you have the Normal view open, the slide master is the larger slide 
image in the slide thumbnail pane.  The associated layouts are positioned 
beneath the slide master. 

4. Customize the existing master slide and its associated layouts to suit your needs 
(e.g., apply a design, theme-based colors, fonts, effects, backgrounds) ensuring 
that your changes meet accessibility requirements 

5. Go to menu item: Office > Save As > Other Formats 
6. In the File name box, type a file name 
7. In the Save as type list, select PowerPoint template 
8. Select Save 
9. On the Slide Master tab, in the Close section, select Close Master View 

 

 

Logical Tab Order 
Many presentations create content that is composed of ‘floating’ objects. This means 
they avoid transitions between in-line content and secondary ‘floating’ objects (text 
boxes, images, etc.) that can create accessibility issues.  

When working with ‘floating’ objects, it is important to position it in a logical order. The 
order the content is navigated is called the Tab Order because the tab key can be used 
to navigate from one object to the next.  

Setting the Tab Order 

1. Go to menu item: Home 
2. In the Drawing section, select Arrange > Selection Pane… 
3. In the Selection and Visibility pane, all the elements on the slide are listed in 

reverse chronological order under Shapes on this Slide  
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4. Elements can be re-ordered using the Re-order buttons located at the bottom of 
the Selection and Visibility pane 

 

 

Slide Notes 
PowerPoint offers the option to add notes to each slide. This can be read by assistive 
technologies and provides more content regarding the text on the screen. It is also a 
good option when using images that contain meaningful content that is too long to 
include in an Alt Text. 

Adding Notes 

1. Go to menu item: View 
2. In the Presentation Views section, select Normal to ensure that the notes panel 

is in view 
3. Note: You can then select menu item Home, to access text formatting options 
4. The Notes Pane can be found at the bottom of the window, below the slide 
5. Put a unique title on every slide 

a. Since PowerPoint does not provide a document heading structure, people 
using screen readers will use the slide titles when looking for a specific 
page in the slideshow  

b. if duplicate slide titles are found on multiple slides, it will be much harder 
to locate a specific slide 

6. Type and format your notes within the Notes Pane below each slide 

Motion, Blinking, Transitions and Animations 
Blinking, flashing and moving content can create accessibility issues. Do not use 
elements that flash, blink or have repetitive motion faster than 3 times per second.  

Slide transitions are effects used to move from one slide to the next. An example of a 
transition is when the slide slowly fades away and the next slide slowly appears. 
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An example of an animation is when you have bullet points appear one at a time on a 
page until the entire slide is displayed.  

Use transition and animation effects sparingly. While they can be useful during live 
presentations they can create accessibility issues or may create distractions. Screen 
readers do not work well with transitions and it can lead to confusion for the user.  

Multimedia and Figures 
If you include multimedia content such as audio or video, it must be accessible 

• Video content must have closed captions 
• Audio content must have transcripts 

If embedding YouTube videos into the slideshow, select a video that has captions 
available already.  

Insert a Video 
1. In your web browser, locate the video you want 
2. Copy the URL of the web page from the Address bar of your browser 
3. Switch back to PowerPoint and select the slide where you want to place the 

video 
4. On the Insert tab of the ribbon, select Video > Online Video 
5. In the Online Video dialog box, paste the URL you copied in step 2 
6. Select Insert 

If a video is inserted successfully, you can play it either in Normal view or Slide Show.  

• A Play button appears on the video in Normal view 
• In Slide Show, you can interact with videos just as you would in a web browser 
• By default, videos from YouTube and Vimeo can play by clicking the spacebar  
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Subtitles 
If you're in the middle of giving a presentation and want to turn the feature on or off, 
click the Toggle Subtitles button from Slide Show View or Presenter View, on the 
toolbar below the main slide: 

In Slide Show View: 

 
In Presenter View: 

 
You can also toggle subtitles from the right-click menu, or with the shortcut key Alt+J. 

To have subtitles always start up when a Slide Show presentation starts, from the 
ribbon you can navigate to Slide Show > Always Use Subtitles to turn this feature on 
for all presentations. (By default, it's off.) Then, in Slide Show and Presenter View, a live 
transcription of your words will appear on-screen. 

Shapes 
PowerPoint allows shapes to be added to a page. The Insert Shapes dialog has several 
geometric shapes, arrows, equations, signs, symbols etc. that can be used. 

A screen reader will treat shapes the same as other content on the slide. However, Alt 
Text should be added to the shape. If the shape is decorative, select the decorative 
option in the Alt Text section.  

Title 
People who are blind, low vision, or have a reading disability rely on slide titles to 
navigate the content. When skimming or using a screen reader they can quickly scan 
through the list of slide titles and select the slide they want to go to. 

• All slides should have a unique title that describes the content the slide contains. 
• Repetitive titles will be flagged in the Accessibility Checker 

Font Size and Colour 
People with disabilities can find text hard to read if it is too small or too busy 

• Use a font size of 18pt or higher in any of the accessible fonts listed in the guide 
• Avoid having too much white space or areas that look crowded or illegible  
• Ensure the colour contrast is compliance with the WCAG 2.0 Level AA 
• Select font and slide colours from the colour options provided in the guide  
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Creating Accessible Excel Spreadsheets  
For the full details on how to create accessible documents in Microsoft Word, go to the 
following: Make Your Excel Documents Accessible  
 
Common Practices in Excel 
These practices are aimed at making all spreadsheets more accessible and legible. 

Worksheet Names and Table Titles 
To change the name of the worksheet tab or for each table, double click on the tab 
name and type in a new name. The name can only have 31 characters.  

 

Row and Column Headers 
Each table should have a row and column headers for each column and row to ensure it 
makes sense. Do not leave any headers blank, even if the meaning seems obvious. 

 

No Blank Data Cells 
Cells should not be left blank either, if the cell has no data put “this cell is intentionally 
left blank” or “no data.” This can be in normal text or change the font colour to match the 
background so only screen readers will read it.  

 

https://support.microsoft.com/en-us/office/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593
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Remove Comments 
Remove extra comments before publishing (example: notes you were using when 
reviewing the spreadsheet). Screen readers cannot read the notes and so if the 
information is important, copy and paste it into a cell. 

 

Set Print Area 
Ensure print areas is set correctly.  

1. Highlights the entire areas of the table including titles and other information 
2. In the ribbon, select Print Layout 
3. In the Page Setup group, select Print Area, and then click Set Print Area 

 

Hide Unused Rows and Columns 
Hide extra rows and columns that are outside the print area making the worksheet look 
less cluttered and prevents screen reader users and keyboard navigators from wasting 
time scrolling through blank cells. 

 
Hide Columns: 

1. To begin, select the first column you want to hide 
2. While holding down the Shift key, press and release the End key on your 

keyboard 
3. Still holding down the Shift, now choose the right arrow key  

a. this selects all columns from the first one you selected all the way to the 
right end of the spreadsheet 

4. Now, with your cursor hovering in the selected area, right-click and choose Hide 
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Hide Rows 

1. To hide unused rows below your data, follow a similar procedure  
2. Leave one blank row below your data, then select the first row you want to hide 
3. Hold Shift as you press and release End and then press and release the down 

arrow key 
4. Right-click and choose Hide 

If you need to unhide these cells later follow these steps: 

1. Select the last visible column 
2. Hover just to the right of the right edge of the column header 

a. Your cursor should turn from a single cursor with arrows into a double 
cursor with arrows 

3. Click and drag to the right, exposing the very last column  
4. Select the new, final column, and right-click and choose Unhide 

Delete Unused Worksheets 
Delete unused worksheets by right-clicking on the tab of the unused worksheet and 
select Delete.  

Note: this cannot be undone, ensure you are deleting the correct worksheet. 

Table Titles 
Table titles should be placed in the first column so screen readers can find them easily. 

 

Avoid Blank Rows and Columns  
• Resize your rows and columns to give the spacing that helps make the table 

readable rather than using blanks to create your spacing 
• One common mistake is leaving column A blank (because it makes it look like a 

margin) 
• Avoid merging cells 
• Type End of Worksheet in the row immediately after the last row of your table  

 
Colour  
When using colour in Excel, the same rules apply in that it must be accessible, the 
contrast must meet the WCAG 2.0 Level AA requirements, and it must be selected from 
the list of colour options in this guide and Appendix H.  

Minimize use of colour in spreadsheets, when possible.  
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Creating Accessible PDFs 
For the full details on how to create accessible PDFs in Adobe, go to the following: 
Create and Verify PDF Accessibility (Acrobat Pro) 
Creating Accessible PDFs 
 
Note: the Accessibility Checker is only available in the paid version of Adobe. The 
free version does not include the features needed to make the document accessible.  
 
The key to ensuring the PDF document has minimal to no accessibility issues is to 
ensure the original document (in Word, PowerPoint, Excel, Canva, etc.) is accessible.  
 
After converting the document to Adobe PDF you will want to run the Accessibility 
Checker.  
 
Two issues that are flagged in all PDFs under Document are: 

• Logical Reading Order 
• Color Contrast  

 

 
 
These both require manual check to ensure they are accessible. Most of the time, if the 
document is accessible in Word or any other software before being converted, these will 
have been checked beforehand. You can right-click on both and select Pass. 
 
If you are not sure, you can check these by using the tab key or a screen reader to 
check the reading order, and using the Contrast Checker to ensure the colour contrast 
is accessible.  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html


28 
 

Document Title 
The document title may not be properly set up prior to converting it to PDF.  

To fix this, click on Document and right click on Title -Failed, and select Fix. Click the 
check box that says Leave As Is under Title and enter in the document title. Click OK.  

  

Document Language  
Sometimes the PDF document will flag the language as an error. To fix this, click on 
Document then right click on Primary Language and select Fix.  

A box should appear showing the language as English, click OK.  
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Tables and Table Summary  
The most common issue for tables is that it does not have a Summary.  

 
To make sure that you are screening for this, click on the Table option in the 
Accessibility Checker menu. If it shows that it has been Skipped, right click on 
Summary and click Skip Rule. If there are no summaries it will say Failed.  
 

 
 
To fix the error, click on each Element to identify the tables that need a summary.  
 
On the right navigation menu click on Reading Order and go to the first table under 
Element 1. Right click on the actual Table and select Edit Table Summary. 
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Enter a description of the table in the Table Summary in the box and click OK. Repeat 
this step for all Elements shown in the Accessibility Checker under Summary.  

Close the Reading Order box after adding a summary to all the tables that require one. 

Once you have closed the reading order box, right click on Summary -Failed and select 
Check Again. It should say Passed if you have edited all the elements correctly. 

Table Headers 
If a Table is missing a header row or the header row is not specified, the Accessibility 
Checker will flag it.  

  
To fix this, right click on the Element 1 and select Show in Tags Panel. Once you see 
the table in the tags panel, click the drop-down arrow to show all the rows (see above).  
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Select the first TR tags to show all the TD tags. Double click on the TD tags and 
change them all to TH tags.  

Go back and do the same for all other Elements under Headers. Once finished, right 
click on Headers -Failed and select Check Again. It should say Passed.  

Note: this can sometimes lead to other errors, it is best to set the header row in 
Microsoft Word before converting the document to Adobe PDF. 

Regularity  
This will fail if the table does not contain the same number of columns in each row or 
rows in each column. This has to be fixed in Word before converting to PDF. 

Tagged Content  
If the content in the PDF is not tagged correctly, the Accessibility Checker will flag it. 

 
To fix this, go to the right navigation menu and click Autotag Document. In most cases 
this should resolve the Tagged Content issue. 
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To check, click the Accessibility Checker button on the left navigation menu to go 
back to the checker, and right click on Tagged content and select check again.  

The Tagged content should say passed. However, it may result in the Tagged 
annotations failing.  

Tagged Annotations 
If there are links throughout the document that are not correctly tagged, even after using 
the Autotag Document option, the Accessibility Checker will show the Tagged 
Annotations has failed.  

 
To resolve this, it needs to be tagged manually. 

Click the drop-down arrow for Tagged annotations and it should show all the 
Elements that are missing tags.  
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Then click on the tags icon in the left navigation menu to open the tagged content.  

 
Once the Tags menu has opened, right click on any of the tags and select Find… 

This opens a new box that is called Find Element. In the drop-down menu click 
Unmarked Links and select Search Document then click Find. 
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This is going to identify all the untagged links in the document. The first one will show 
up with a purple box around it. Click Tag Element in the same find box as above. It 
should mark it as a Link and then go to the next unmarked link.  

 
Continue clicking Tag Element until all unmarked links are tagged.  

Once completed, close the Find Element box and go back to the Accessibility 
Checker, right click on Tagged annotations and select Check Again. It should say 
Passed if all the untagged links were properly tagged. 

Navigation Links  
Sometimes this will show that it needs manual checking. This means determining if links 
are redirecting to the correct page. Check that all links redirect to the correct page.  

Once completed, right click on Navigation Links and select Pass. 

Figures Alternate Text 
When images are used in a PDF document they need to have an Alternate Text tag. If 
they are missing an Alt Text tag the Accessibility Checker will flag it. 
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To fix this, open the Figures alternate text -Failed and it will show a list of all the 
Figures missing Alt Text tags.  

Right click on Figure 1 and select Fix. This should open the Set Alternate Text box.  

 
If the image is decorative, click Decorative Figure, if it contains meaningful information 
or is not decorative, write a description in the Alternate Text box, and click the right 
arrow to go to the next image.  

Do this for all the figures that are missing an Alt Text and then click Save & Close.  

Right click on Figures alternate text -Failed and select Check Again. It should say 
Passed if you have correctly added an Alt Text tag to all figures that required it.  

Headings Appropriate Nesting 
If the headings tags are not done in the correct order the Accessibility Checker will flag 
it and indicate that the appropriate nesting failed.  
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To fix this, right click on the Element 1 and select Show in Tags Panel.  

It should show the order of headings under that section. In this example it says H1 and 
then Element 1 is tagged as H3.  

 
Once you have identified the order it should go in, double click on the heading that is 
creating the issue and change the tag to the correct one. 

In this example, it should be H2 not H3, so change the tag to H2. Make sure there are 
no other headings that get flagged once the heading is changed.  

Once all Elements are fixed, go back to the Accessibility Checker and right click on 
Appropriate nesting -Failed and select Check Again. It should say Passed. 

Forms Field Description 
If there is no description in the tooltip section of a form field, it will flag Field Description 
as a failed accessibility error  
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To add a text description to a form field select one of the Form tools (Prepare Form), 
and then right-click the form field 

Choose Properties from the context menu, and click the General properties tab 

Enter a description of the form field in the Tooltip field 

Note: the description in the Tooltip field should explain what should go in the form field. 
It can be the same as the name if it properly describes the field.  

 
When the document is auto-tagged it may accurately take most form fields, but there 
may be some that do not get named correctly. In this case, you can change the name to 
match the Tooltip when editing it in the General Properties box.  
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For the above image, you can change the name of Text2 to Director Signature, and the 
name of Text3 to CAO Signature. 

Tagged Form Fields 
When form fields are not correctly tagged, it will flag it as an accessibility error.  

 
To fix this, first see if you can select Autotag Form Fields in the right navigation menu 

  
This may not resolve all of the issues, in which case, try selecting Autotag Document 
above the Autotag Form Fields in the right navigation menu and then right click on 
Tagged Form Fields and select Check Again. It should resolve remaining tag issues.  
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Creating Accessible InDesign Documents  
For details on making InDesign accessible, visit Accessibility Products InDesign 

InDesign CC supports accessible cross-media publication, allowing you to export 
InDesign documents to PDF, XHTML, and XML. Users can add tags and alternative text 
attributes to InDesign documents that support the production of accessible content in 
these exported formats. Now you can easily map styles to PDF tags.  

When InDesign exports the tagged PDF, those mapped tags automatically define the 
role map in Acrobat. You can create articles from a combination of existing page items 
within a layout, including images, graphics, or text. Once an article has been created, 
page items can be added, removed, or reordered. While articles can be created 
manually by dragging one or more page items to an article in the Articles panel, there 
are also mechanisms for adding bulk content to an article, including adding all selected 
content to an article or adding an entire document to an article.  

The Articles panel is designed to be simpler and easier to use for people without XML 
skills. Note that the ability to use the XML Structure panel has not been removed; it is 
now an additional option that complements the use of the Articles panel during the 
export process. 

 

Mapping Style Tags 
The Paragraph and Character Style dialog box has the option to use Export Tagging.  

Export Tagging is found in the Paragraph Styles Options menu, and it can be used to 
define how text with InDesign Styles should be marked before converted to PDF. The 

https://www.adobe.com/accessibility/products/indesign.edu.html
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markup is displayed in a dropdown menu that has common tags such as <H1> to <H6>, 
<P> or Artifact. Export Tagging cannot be previewed within the InDesign layout, but it 
will be marked up in the exported PDF file. 

 

Alternative Text 
The Object Export Options dialog box provides four options for adding alt text to frames 
in InDesign CC: 

From Microsoft Word: When InDesign users import Word documents with graphic 
images that have had the alt text assigned in Word, the alt text descriptions from Word 
are converted to native InDesign alt text. (Note: Currently supported only on the 
Windows® version of Word).  

From Structure: This option is for legacy INDD files where users have already created 
all of the alt text using the Structure pane. 

From XMP (Title | Description | Headline): Common XMP metadata fields are used to 
capture text about the image or graphic. If the XMP data is updated in another 
application like Adobe Bridge, updating the link in InDesign results in the alt text string 
being updated. 

To add alt text by typing it directly into InDesign: 
1. Select an image that does not have an alt text tag  
2. With the Selection Tool, select the image  
3. Choose Object > Object Export Options 
4. Select the Alt Tab in the Object Export Options box 
5. Choose Custom from the Alt Text Source menu 
6. Enter the description in the field and click Done  
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Artifact Objects 
Apply artifact tags to object styles for any elements that should be tagged as an artifact: 

• Decorative blocks of colour 
• Decorative elements such as rules 
• Decorative background images  

 
Alternatively, right-click on the object and select Object Export Options and select 
Tagged PDF > Artifact 

For more in-depth instructions on accessible InDesign documents, go to the 
presentation on Using Adobe InDesign to Create Accessible PDF Documents 

  

https://www.doi.gov/sites/doi.gov/files/uploads/may_2019_section_508_compliance_event_-_indesign_accessibility.pdf
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Canva Accessibility 
Canva is a free easy-to-use design tool which makes graphic design easy to use for 
learners with all levels of abilities, from complete beginners to experienced designers. 

Canva’s simple drag and drop function combined with thousands of pre-made layouts 
enables users to quickly and easily create a wide range of different designs. Choose a 
template to create: 

• A4 posters 
• Blog graphics 
• Social media posts 
• CVs 
• Infographics 

Canva also allows users to customize and create their own templates.  

Canva does not have a built-in accessibility checker. Although it is useful for making 
graphic content or posters, flyers, brochures, it is important to use the accessibility 
checkers in Adobe or Microsoft to ensure that it is accessible.  

General Tips for Creating an Accessible Canva 
• Use as few text boxes as possible  

o It is easier to have several separate paragraphs in one text box versus 
several individual text boxes per paragraph 

• Design with the reading order in mind  
o It may be attractive to put the title in the middle of the page with an image 

blended into the background but it is not going to be accessible  
• Group together decorative elements 

o When grouping together decorative elements you can ensure they have a 
decorative tag rather than needing to provide an Alt Text description (this 
can only be done for images that are purely decorative) 

To learn how to check accessibility for Canva in Adobe or Microsoft, visit the article by 
Fresh Spectrum Canva Accessibility is Bad, Here is How You Fix Your Design 

Alternatives to Canva 
• Photoshop and InDesign – part of the Adobe suite, these programmes are paid-

for alternatives  
• Pixlr – Pixlr Editor allows you to edit images in a similar way to Photoshop using 

layers while Pixlr Express enables you to quickly edit images and create collages 
• Inkscape – free vector graphics software available on Mac, Windows and Linux 

  

https://www.canva.com/login?shouldClearGotAutoSelect
https://freshspectrum.com/canva-accessibility/
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Creating Accessible Social Media Posts  
Facebook 
Facebook has an accessibility page that provides details for users who have a disability 
or for creators who want to make their page more accessible: Facebook Accessibility 

Alternative Text for Facebook Images 
Facebook has a built-in Alternative Text generator, to understand how this works go to: 
How Does Automatic Alt Text Work on Facebook? 

However, you can edit the Alt Text to ensure it is accurately conveying the information 
you want it to show to other users. To learn more about how to edit the Alt Text on 
Facebook, go to: How Do I Edit the Alternative Text for a Photo on Facebook?  

It is important to note this can only be done on a laptop as it is not available on a phone. 

 

Facebook Captions for Images 
If the photo contains meaningful information that cannot be conveyed in an Alt Text, 
use the caption to add a description of the information in the image.  

Alternatively, link the description of the information contained in the image in the 
caption.  

Try to avoid using images with text when possible or be sure to include a full 
description of the text in the caption or a link that is provided in the caption.  

This is done to ensure that people with disabilities can access all the same information 
as abled-bodied individuals. Do not summarize the information or leave out details.  

https://www.facebook.com/help/accessibility
https://www.facebook.com/help/216219865403298/?helpref=search&query=alt%20text&search_session_id=674b03c1821c4bd77e3a1ac45e1a3f95&sr=0
https://www.facebook.com/help/214124458607871/?helpref=search&query=alt%20text&search_session_id=674b03c1821c4bd77e3a1ac45e1a3f95&sr=1
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Accessible Facebook Post 
The caption below includes the same details, even though it is worded slightly different 
from the image. It does not summarize and leave any important information out.  

For more complex images or where more information is needed, include a link to 
where the full description is, or a description at the end of the caption above the image.  

 

Image Description Instructions 
Oftentimes inaccessible posts are ones that include images with meaningful information 
that is not provided in another format either via a link or description in the caption. 

The image below contains meaningful information that is not conveyed in another 
format. To fix this, add a description in the caption or provide the details in a link. 

Since the text in the image is lengthy it is best practice to put the full details in a link.  

To do this, type out the information in the image in a PDF document or on a 
webpage on the website, and include the link in the post. If the image is borrowed 
from another website, see if they have the information typed out already and link to that 
website. For the post below, write out the statistics in plain, easy to read, language.  
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Automatic Closed Captions on Videos 
Facebook, like YouTube, automatically captions its videos. However, you can also edit 
the auto-generated captions. To do this, visit How Do I Add Captions to my Page’s 
Video on Facebook? 

Language Simplicity on Facebook 
It is important to keep the readability of Facebook posts and images in mind. Readability 
should be targeted at a grade eight level.  

To test the readability of the Facebook posts, go to the WebFX Readability Test  

Colour Contrast for Facebook 
It is important to keep colour contrast of images in mind when making Facebook posts. 
To check the colour contrast, go to page 12-14 of this guide.  

Instagram 
Instagram has a page on Accessibility in the Help Center that goes over some 
accessible features.  

https://www.facebook.com/help/509746615868430
https://www.facebook.com/help/509746615868430
https://www.webfx.com/tools/read-able/
https://help.instagram.com/308605337351503
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Alternative Text  
Instagram uses an Automatic Alt Text and object recognition technology to provide a 
visual description of the images. The text can be replaced with a better description. 
These descriptions are able to be read by screen readers. 

To see and edit alt text for a photo before you post it on Instagram: 

1. Start by taking a photo or uploading an existing photo to Instagram 
2. Choose a filter and edit the image, then tap Next (iPhone) or  (Android)  
3. Tap Advanced Settings at the bottom of the screen 
4. Tap Write Alt Text 
5. Write your alt text in the box and tap Done (iPhone) or Done (Android) 

To change the alt text of a photo after you've already posted it on Instagram: 

1. Go to the photo and tap (iPhone) or (Android) 
2. Tap Edit 
3. Tap Edit Alt Text in the bottom right 
4. Write the alt text in the box and tap Done (iPhone) or Done (Android) 

 

Image Descriptions 
Some images contain meaningful information that cannot be captured in an Alt Text tag. 
It is better to provide an image description in the caption to ensure all users are 
accessing the same content.  

See Facebook section above for more details on how to add an image description.  

Minimize use of font styles, emoji’s, icons, in Instagram posts.  

Caption and Description for Videos 
It is important to use videos that have closed captions when uploading to Instagram. 
This has to be done in a video editing software before uploading.  
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You can use a third-party app to auto-generate video captions, visit this article on the 7 
Best Automatic Subtitle Generators to find more information on captioning videos.  

Sharing Videos with Captions 
You can manage captions for your own video post before or after sharing it. 

To manage captions before sharing a video post: 

1. Before sharing a video post, tap Advanced Settings 
2. Scroll to Accessibility and tap switch off or switch on next to Show Captions 

to turn it on or off 

To manage captions for a video post you already shared: 

1. Tap more actions (Android) or more actions (iPhone) at the top of the video 
2. Tap Edit 
3. On an Android, tap Remove Captions to turn them off. On an iPhone, tap 

Advanced settings, then tap switch off or switch on next to Show captions to turn 
them on or off 

4. If the video cannot contain closed captions, link to transcripts of the video. 

It is also best practice to provide a brief description in the caption on what the video is 
about to help users identify the video and determine if the content is relevant to them. 

Other Accessibility Practices  
According to the blog on How to Make Your Instagram More Accessible and Why It’s 
Important, there are a few tips to ensuring the content is accessible to all users.  

• Keep posts brief and concise, use plain text and easy to understand language  
• Limit the use of Emojis 
• Place extra hashtags in the comments instead of at the end of the post  
• Optimize colour contrast and ensure that you are complying with WCAG 2.0 
• Avoid putting critical information in Instagram Stories   

LinkedIn 
LinkedIn has an Accessibility page that states the site is in compliance with the WCAG 
2.1 Level AA. To contact LinkedIn for accessibility support, go to: Contact LinkedIn 
Support – Accessibility Support Request(s). 

The Bureau of Internet Accessibility wrote a blog on Becoming More Accessible on 
LinkedIn: Tips for Improving Your Reach. It includes the following tips: 

1. Add descriptive alternative text to your LinkedIn posts  
It must be done in a desktop, it is not currently available on mobile devices 

a) Upload image 
b) Press Add Alt Text in the top right corner 
c) Type your Alt Text in the box and press Save 

https://filmora.wondershare.com/video-editing-tips/best-automatic-subtitle-generators.html
https://filmora.wondershare.com/video-editing-tips/best-automatic-subtitle-generators.html
https://www.ibeccreative.com/blog/how-to-make-your-instagram-more-accessible-and-why-its-important
https://www.ibeccreative.com/blog/how-to-make-your-instagram-more-accessible-and-why-its-important
https://www.linkedin.com/accessibility
https://www.linkedin.com/help/linkedin/ask/DAD
https://www.linkedin.com/help/linkedin/ask/DAD
https://www.boia.org/blog/becoming-more-accessible-on-linkedin-tips-for-improving-your-reach
https://www.boia.org/blog/becoming-more-accessible-on-linkedin-tips-for-improving-your-reach
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If the Alt Text cannot capture all of the meaningful information in an image, add an 
image description in the post or under the image. See the image description 
instructions that is provided under the Facebook section above  

2. Add closed captions to LinkedIn videos  
Consider a third-party app to auto-generate captions (see information under 
Caption and Description for Videos under Instagram) 
 

3. Ensure the content follows the WCAG 2.0 Level AA requirements  
Pay attention to colour contrast  
Use clear and concise language and avoid jargon 
Avoid flashing content more than 3 times per second  

YouTube  
YouTube has a page on how to Manage Accessibility Settings that provides general 
accessibility information and specific information for people who have a visual or 
hearing disability.  

Closed Captions 
For more information, visit YouTube Help Add Subtitles and Captions. 

https://support.google.com/youtube/topic/9257112?hl=en&ref_topic=9257107
https://support.google.com/youtube/answer/2734796?hl=en
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Create subtitles and captions 
1. Sign in to YouTube Studio 
2. From the left menu, select Subtitles 
3. Click the video that you'd like to edit 
4. Click Add Language and select your language 
5. Under subtitles, click Add 

Additional Resources on Accessible Technology 
According to SNOW Inclusive Learning & Education: Assistive technology is a piece 
of technology (software or hardware) designed to perform a specific task. For example, 
a braille keyboard for an individual who reads braille, screen reader software that reads 
content out loud from digital text, or speech-to-text software that allows people to use 
their voices to enter text. It can help people with disabilities with the following: 

• Perform functions that cannot be accessed in another format 
• Approximate normal fluency, rate or standards that cannot otherwise be achieved 
• Allow for full participation in programs or activities that are otherwise inaccessible 
• Enhance endurance or ability to complete tasks that are otherwise difficult  
• Assists with concentration and increases access to information 

Apps for those who are Deaf and Hard of Hearing: 

Google Live Transcribe: This Google app allows anyone to listen to a conversation 
and read a transcript of what was said.  

AVA: This app uses AI to convert an audio recording into text for the user. It also allows 
the user to send messages with closed captioning. The app requires an internet 
connection and will not work without it. 

Signly: This app converts sign language into text or speech. It also includes a text-to-
speech function to convert written words into audio. 

Apps for those who are Blind or Low Vision: 

KNFB Reader App: This app scans a document and reads it aloud as soon as the 
device picks up its text. This works for anything from books, magazines, and letters to 
websites and emails. 

TapTapSee: This app allows you to take a picture of an object and tells you what it is. It 
also provides visual descriptions, identifies currency values, and describes colors. 

Color ID Free: This app allows you to take a picture and then identify colors in the 
photo. It also includes the ability to scan barcodes and QR codes, read signs, and 
describe shapes.  

https://snow.idrc.ocadu.ca/assistive-technology-2/
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WCAG 2.0 Level A and AA Checklist 
The following information can be found on Yale University WCAG 2 A and AA Checklist 

1.1.1 Non-text Content (A) (2.0) 

• All image tags must have Alt attributes 
• If short Alt Text is enough to describe an image, provide the short text via the 

image's alt attribute 
• If a short text alternative is not enough to describe an image (such as in a chart, 

graph, or diagram), provide short text via the image's alt attribute, and include a 
long description in nearby text 

• If an image or icon is used as a button or link, the image has a text alternative 
enough to describe the purpose of the button or link 

• Images that are decorative, used for formatting, or contain content already 
conveyed in text have a null alt attribute or are implemented as CSS background 
images 

• Frames and iframes have descriptive titles 
• Minimize the number of adjacent links to the same destination by combining 

adjacent images and text into a single link, rather than creating a separate link for 
each element 

1.2.1 Audio-only and Video-only (Prerecorded) (A) (2.0) 

• For pre-recorded audio (without video), provide a descriptive transcript that 
includes dialogue and all other meaningful sound 

• For pre-recorded video (without audio), provided a text alternative or audio 
descriptions that provide the same information presented 

1.2.2 Captions (Prerecorded) (A) (2.0) 

• Provide captions for pre-recorded audio content in non-live synchronized media 
1.2.3 Audio Description or Media Alternative (Prerecorded) (A) (2.0) 

• For non-live video, provide a descriptive transcript or an audio description 
1.2.4 Captions (Live) (AA) (2.0) 

• Provide captions for live audio and video 
1.2.5 Audio Description (Prerecorded) (AA) (2.0) 

• Videos should include "radio style" narration so that content makes sense if 
someone is consuming just the audio track  

• Include any text elements in the narration 
1.3.1 Info and Relationships (A) (2.0) 

• Use semantic markup to designate headings, lists, figures, emphasized text, etc. 
• Organize pages using properly nested HTML headings 
• Use ARIA landmarks and labels to identify regions of a page 

https://www.w3.org/WAI/WCAG21/Understanding/non-text-content
https://www.w3.org/WAI/WCAG21/Understanding/audio-only-and-video-only-prerecorded
https://www.w3.org/WAI/WCAG21/Understanding/captions-prerecorded
https://www.w3.org/WAI/WCAG21/Understanding/audio-description-or-media-alternative-prerecorded
https://www.w3.org/WAI/WCAG21/Understanding/captions-live
https://www.w3.org/WAI/WCAG21/Understanding/audio-description-prerecorded
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships
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• Reserve tables for tabular data, use table headers appropriately, and use table 
captions 

• When the appearance of text conveys meaning, also use appropriate semantic 
markup 

• Avoid emulating links and buttons 
o Use the a and button tags appropriately. Avoid using a tags for buttons. 

Avoid using div, span, etc. tags for links or buttons 
• Avoid using whitespace characters for layout purposes 

1.3.2 Meaningful Sequence (A) (2.0) 

• Ensure that the source order presents content meaningfully  
• When the page is viewed without styles, all content on the page should still 

appear in a meaningful and logical order 
1.3.3 Sensory Characteristics (A) (2.0) 

• Do not identify content based on its color, size, shape, position, sound, or other 
sensory characteristics 

• Do not convey information solely through icons or symbols 
1.4.1 Use of Color (A) (2.0) 

• When the color of words, backgrounds, or other content is used to convey 
information, also include the information in text 

• Links should always be easily identifiable through non-color means, including 
both default and hover states 

o The easiest and most conventional way to signify links is underlining 
• Required fields and fields with errors must include some non-color way to identify 

them 
1.4.2 Audio Control (A) (2.0) 

• Do not have audio that plays automatically on the page  
• When providing audio, also provide an easy way to disable the audio and adjust 

the volume 
1.4.3 Contrast (Minimum) (AA) (2.0) 

• Text (including images of text) have a contrast ratio of at least 4.5:1 
• For text and images of that is at least 24px and normal weight or 19px and bold, 

use a contrast ratio that is at least 3:1 
1.4.4 Resize text (AA) (2.0) 

• Ensure that there is no loss of content or functionality when text resizes 
• Define texts and text containers in relative units (percent, ems, rems) rather than 

in pixels 
1.4.5 Images of Text (AA) (2.0) 

• Avoid images of text, except in cases such as logos 

https://www.w3.org/WAI/WCAG21/Understanding/meaningful-sequence
https://www.w3.org/WAI/WCAG21/Understanding/sensory-characteristics
https://www.w3.org/WAI/WCAG21/Understanding/use-of-color
https://www.w3.org/WAI/WCAG21/Understanding/audio-control
https://www.w3.org/WAI/WCAG21/Understanding/contrast-minimum
https://www.w3.org/WAI/WCAG21/Understanding/resize-text
https://www.w3.org/WAI/WCAG21/Understanding/images-of-text
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2.1.1 Keyboard (A) (2.0) 

• Avoid implementing access keys 
o When access keys and other keyboard shortcuts are implemented, they 

must not interfere with existing browser and screen reader provided 
shortcuts 

• All functionality should be available to a keyboard without requiring specific 
timing of keystrokes unless a keyboard cannot provide the functionality alone 

• Avoid relying exclusively on pointer-driven events, such as onmouseover, to 
provide functionality when scripting 

o Generally, such functionality will also require scripting for keyboard 
operability 

• In general, avoid using scripts to remove focus from an element until the user 
moves focus manually 

2.1.2 No Keyboard Trap (A) (2.0) 

• Ensure keyboard focus is never trapped on an element without an obvious way 
to move focus out of the element  

• Make sure the user can move focus to and from all focusable elements using a 
keyboard only 

2.2.1 Timing Adjustable (A) (2.0) 

• Do not require time limits to complete tasks unless necessary  
• If a time limit is necessary, the time limit should be at least 20 hours, or it can be 

extended, adjusted, or disabled 
2.2.2 Pause, Stop, Hide (A) (2.0) 

• Items on the page should not automatically move, blink, scroll, or update, 
including carousels 

• If content does automatically move, blink, scroll, or update, provide a way to 
pause, stop, or hide the moving, blinking, scrolling, or updating 

2.3.1 Three Flashes or Below Threshold (A) (2.0) 

• Do not provide any content that flashes more than three times in any 1-second 
period 

2.4.1 Bypass Blocks (A) (2.0) 

• Provide a link to skip to the main content as the first focusable link on the page 
2.4.2 Page Titled (A) (2.0) 

• Make sure each web page has a title tag that is descriptive, informative, and 
unique 

2.4.3 Focus Order (A) (2.0) 

• Create a logical tab order through links, form controls, and interactive objects 

https://www.w3.org/WAI/WCAG21/Understanding/keyboard
https://www.w3.org/WAI/WCAG21/Understanding/no-keyboard-trap
https://www.w3.org/WAI/WCAG21/Understanding/timing-adjustable
https://www.w3.org/WAI/WCAG21/Understanding/pause-stop-hide
https://www.w3.org/WAI/WCAG21/Understanding/three-flashes-or-below-threshold
https://www.w3.org/WAI/WCAG21/Understanding/bypass-blocks
https://www.w3.org/WAI/WCAG21/Understanding/page-titled
https://www.w3.org/WAI/WCAG21/Understanding/focus-order
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• When inserting content into the DOM, insert the content immediately after the 
triggering element, or use scripting to manage focus in an intuitive way  

o When triggering dialogs and menus, make sure those elements follow 
their trigger in the focus order in an intuitive way 

o When content is dismissed or removed, place focus back on the trigger 
• Avoid using tab index values greater than 0 

2.4.4 Link Purpose (In Context) (A) (2.0) 

• If the visible text alone is not sufficient to convey meaning, use advanced 
techniques to provide additional meaning, such as ARIA attributes, screen reader 
only text, or the title attribute 

• The purpose of each link can be determined from the link text alone, or from the 
link text and the containing paragraph, list item, or table cell, or the link text and 
the title attribute 

2.4.5 Multiple Ways (AA) (2.0) 

• Each website should include at least two of the following: a list of related pages; 
table of contents; site map; search; or list of all pages 

2.4.6 Headings and Labels (AA) (2.0) 

• Ensure that on each page, headings, landmark labels, and form labels are 
unique unless the structure provides adequate differentiation between them 

2.4.7 Focus Visible (AA) (2.0) 

• Provide keyboard focus styles that are highly visible, and make sure that a visible 
element has focus at all times when using a keyboard 

• Do not rely on browser default focus styles 
3.1.1 Language of Page (A) (2.0) 

• When a visual label is present for an interactive element (example: link or form 
control) the accessible name of the element should contain the visual label 

• Provide a lang attribute on the page's html element 
3.1.2 Language of Parts (AA) (2.0) 

• If a portion of the page is in a different language, use the lang attribute on that 
part 

3.2.1 On Focus (A) (2.0) 

• When the focus change, the page should not cause a change in page content, 
spawn a new browser window, submit a form, case further change in focus, or 
cause any other change that disorients the user 

3.2.2 On Input (A) (2.0) 

• When a user inputs information or interacts with a control, the page should not 
cause a change in page content, spawn a new browser window, submit a form, 
cause further change in focus, or cause any other change that disorients the user 

https://www.w3.org/WAI/WCAG21/Understanding/link-purpose-in-context
https://www.w3.org/WAI/WCAG21/Understanding/multiple-ways
https://www.w3.org/WAI/WCAG21/Understanding/headings-and-labels
https://www.w3.org/WAI/WCAG21/Understanding/focus-visible
https://www.w3.org/WAI/WCAG21/Understanding/language-of-page
https://www.w3.org/WAI/WCAG21/Understanding/language-of-parts
https://www.w3.org/WAI/WCAG21/Understanding/on-focus
https://www.w3.org/WAI/WCAG21/Understanding/on-input
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• If an input causes such a change, the user must be informed ahead of time 
3.2.3 Consistent Navigation (AA) (2.0) 

• When components are repeated across web page, they should appear in the 
same relative order with regard to other repeated components on each web page 
where they appear 

• When a navigation menu is presented on multiple pages, the links should appear 
in the same order on each page 

3.2.4 Consistent Identification (AA) (2.0) 

• When components have the same functionality across several web pages, the 
components are labeled consistently on each page 

3.3.1 Error Identification (A) (2.0) 

• Identify errors using aria-invalid 
• Programmatically indicate required fields using the required or aria-required 

attributes 
o Visually indicate required fields in the form's instructions or form labels. Do 

not indicate required fields for CSS alone 
• Make errors easy to discover, identify, and correct 

3.3.2 Labels or Instructions (A) (2.0) 

• Use semantic, descriptive labels for inputs  
o visually position labels in a consistent way that makes associating labels 

with form controls easy  
o do not rely on placeholder text in lieu of an HTML label 

• Provide text instructions at the beginning of a form or set of fields that describes 
the necessary input 

• When providing inline help text, use aria-describedby to associate the help text 
with the input 

3.3.3 Error Suggestion (AA) (2.0) 

• If an input error is detected and if suggestions for correction are known, provide 
suggestions for fixing the submission 

3.3.4 Error Prevention (Legal, Financial, Data) (AA) (2.0) 

• Provide easy ways to confirm, correct, or reverse a user action where a mistake 
would cause a serious real-world consequence  

o Example: submitting financial data, entering into a legal agreement, 
submitting test data, or making a transaction) 

4.1.1 Parsing (A) (2.0) 

• Validate all page HTML, and avoid significant validation / parsing errors 
4.1.2 Name, Role, Value (A) (2.0) 

https://www.w3.org/WAI/WCAG21/Understanding/consistent-navigation
https://www.w3.org/WAI/WCAG21/Understanding/consistent-identification
https://www.w3.org/WAI/WCAG21/Understanding/error-identification
https://www.w3.org/WAI/WCAG21/Understanding/labels-or-instructions
https://www.w3.org/WAI/WCAG21/Understanding/error-suggestion
https://www.w3.org/WAI/WCAG21/Understanding/error-prevention-legal-financial-data
https://www.w3.org/WAI/WCAG21/Understanding/parsing
https://www.w3.org/WAI/WCAG21/Understanding/name-role-value
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• Avoid creating custom widgets when HTML elements already exist, for example, 
use a and button tags appropriately 

• When creating a custom interactive widget, consult the ARIA Authoring Practices 
Document  

o use ARIA labels, descriptions, roles, states, and properties to expose 
information about the component 

• Use ARIA to enhance accessibility only when HTML is not sufficient  
o use caution when providing ARIA roles, states, and properties. 

 
A PDF version of the checklist is available when screening webpages or 
documents. Contact the County Accessibility Coordinator for a copy.  
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